
Overview of QuoteScan

For the avid investor or stock market enthusiast, tracking stock prices can be tricky and time 
consuming. The QuoteScan allows you to check stock prices on all the major North American 
exchanges. With just a few keystrokes, you can receive quotes, and trading volume on all your 
favorite stocks based on a twenty minute delay. 

QuoteScan also allows you to display a floating window that tracks up to five stocks at the interval you
select and can scroll them through the window like a stock ticker tape. You can easily catch the price 
changes when they happen, not the next day.

{button ,AL(`Corel QuoteScan main window;Getting Started;How QuoteScan works;Using 
Help')} Related topics 



How QuoteScan works

After you start QuoteScan, you enter the ticker symbol of one or more stocks and specify how often 
you want the price updated. On the interval you select, QuoteScan sends a request to the PC Quote 
Web Site for the current prices and trading volumes, delayed 20 minutes, on the selected stocks. 
When it receives the information from the Web site, QuoteScan displays the information in its main 
window and, optionally, in a floating window.

{button ,AL(`Getting Started;Overview of QuoteScan;Using Help')} Related topics 



Getting Started

Add a stock ticker symbol
In one of the Stocks to watch text boxes, type the ticker symbol of the stock you want QuoteScan to 
monitor. For example, Corel Corporation is COSFF on the Nasdaq stock exchange. 
{button ,AL(`Finding and adding ticker symbols',1,`',`second')}

Set the Automatic Update Frequency
You need to tell QuoteScan how often you want it to check the price of the stocks you’ve selected. 
Click the Automatic Update Frequency list box and select a frequency. {button ,AL(`Updating the stock
price',1,`',`second')}

Retrieve the stock price
After you've typed a ticker symbol in at least one of the boxes and set the update frequency, click the 
Update Now button. QuoteScan will retrieve the stock price of the selected stock, delayed 20 minutes.
{button ,AL(`Updating the stock price',1,`',`second')}

Configure the floating stock window
Click the Configure button. Enable all of the check boxes and click the OK button. This displays the 
maximum amount of information in the floating window. If you don’t want all of the information 
displayed, disable the check boxes for those features. {button ,AL(`Configuring the floating 
window',1,`',`second')}

Display the floating stock window
Display the small floating window by enabling the Show Floating Window check box. 
{button ,AL(`Configuring the floating window',1,`',`second')}

{button ,AL(`Configuring the floating window;Corel QuoteScan main window;How QuoteScan 
works;How to;Keyboard Short-cuts;Overview of QuoteScan;Updating the stock price;Using 
Help')} Related topics 



Options

The Options dialog box is comprised of three tabs: Browser, Include, and Text. 

The Browser tab provides information to QuoteScan on how it accesses your Web browser.

The include tab allows you to specify the information on the selected stock that you want QuoteScan 
to display for you.

The Text tab allows you to specify the colors that QuoteScan uses when displaying stock information 
in the floating window.

To specify the Web browser that QuoteScan accesses:
1. From the main window, choose the Configure button.
2. In the Options dialog box, choose the Browser tab.
3. Choose either Launch URL or Launch Program and specify a path for your Web browser.

Apply button applies any changes you've made in the Options dialog box to the current session. The
Options dialog box remains open.

Help button displays this Help page.

OK button accepts the settings you’ve specified and exits from this dialog box.

Cancel button exits from this dialog box and discards any setting selections you’ve made.

{button ,AL(`Browser tab (Options dialog box);Include tab (Options dialog box);Text tab 
(Options dialog box)')} Related topics



Browser tab (Options dialog box)

Allows you to configure how QuoteScan launches your Web browser. You’ll use the Web browser 
when you access the PC Quote server to find ticker symbols. If you want Windows 95 to locate an 
appropriate Web browser, enable the Launch URL button and click the OK button. If you want to 
specify which browser you want Web Catalog to launch, enable the Launch Program button, specify 
the path to your Web browser and click the OK button.

Launch URL button sends the URL of the Web page directly to the Windows 95 operating system. 
Windows 95 then launches your Web browser and locates the selected Web page.

Launch Program button instructs QuoteScan to launch your Web browser whenever you open a 
Web page from within QuoteScan.

Path box specifies the path to your Web browser application.

Browse button allows you to view the folders on any drives that are available to your system to make
it easier to locate your Web browser.

Apply button applies any changes you've made in the Options dialog box to the current session. The
Options dialog box remains open.

Help button displays this Help page.

OK button accepts the settings you’ve specified and exits from this dialog box.

Cancel button exits from this dialog box and discards any setting selections you’ve made.



Specifies that you want QuoteScan to send the URL of a Web page directly to the Windows 95 operating system when trying to
access that page. Windows 95 will select and launch a Web browser on your system and locate the selected Web page. 
QuoteScan attempts to access Web pages when you click either the Look Up or PC Quote buttons in the main window.



Specifies that you want QuoteScan to launch a specific Web browser whenever you open a Web page from within QuoteScan. 
QuoteScan attempts to access Web pages when you click either the Look Up or PC Quote buttons in the main window.



Specifies the path to your Web browser application.



Allows you to view the folders on any drives that are available to your system to make it easier to locate your Web browser.



Include tab (Options dialog box)

The Include tab of the Options dialog box allows you to specify which pieces of information you want 
displayed in the floating window. Enable the check boxes of the information you want included and 
click the OK button. 

Include Company Name check box specifies that you want the name of the company indicated by 
the ticker symbol displayed in the floating window. Note that company names aren't available for all 
companies on all stock exchanges.

Include Ticker Symbol check box specifies that you want to display the ticker symbol of the stock in
the floating window.

Include Price check box specifies that you want to include the current trading price of the stock in 
the floating window.

Include Daily Change check box specifies that you want to display the value of the change in the 
stock price from the previous trading day to the current price in the floating window.

Include Volume check box specifies that you want to display the number of shares that have been 
traded in the floating window.

Include Quote Time check box specifies that you want to display the time that QuoteScan last 
checked the price of the selected stock.

OK button accepts the settings you’ve specified and exits from this dialog box.

Cancel button exits from this dialog box and discards any setting selections you’ve made.



Allows you to specify which pieces of information you want to include in the floating window.



Specifies that you want the name of the company displayed in the floating window.



Specifies that you want to display the ticker symbol of the stock in the floating window.



Specifies that you want to include the current trading price of the stock in the floating window.



Specifies that you want to display the value of the change in the stock price from the previous trading day to the current price in
the floating window.



Specifies that you want to display the number of shares that have been traded in the floating window.



Specifies that you want to display the time that QuoteScan last checked the price of the selected stock in the floating window.



This is an example of the information the QuoteScan displays. This information isn't correct for the specified stock.



Text tab (Options dialog box)

The Text tab of the Options dialog box allows you to configure the color settings of the floating window
to make interpreting the information it displays easier. To change the color of any component in the 
floating window, click on the appropriate button and choose the color that you want to use for that 
component from the color palette. Click OK on the color palette dialog box and then click OK in the 
Options dialog box to put your color changes into effect.

Background button specifies the color that you want QuoteScan to use for the background of the 
floating window.

Current Price button specifies the color that you want QuoteScan to use when displaying the current
trading price in the floating window.

Price Up button specifies the color you want QuoteScan to use when displaying the amount of an 
increase in the stock price in the floating window.

Price Down button specifies the color you want QuoteScan to use when displaying the amount of a 
drop in the stock price in the floating window.

Select Font button displays a dialog box that allows you to specify the type style and type size that 
you want QuoteScan to use in the floating window.

OK button accepts the settings you’ve specified and exits from this dialog box.

Cancel button exits from this dialog box and discards any setting selections you’ve made.



Specifies the color that you want QuoteScan to use for the background of the floating window.



Specifies the color that you want QuoteScan to use when displaying the current trading price in the floating window.



Specifies the color you want QuoteScan to use when displaying the amount of an increase in the stock price in the floating 
window.



Specifies the color you want QuoteScan to use when displaying the amount of a drop in the stock price in the floating window.



Displays a dialog box that allows you to specify the type style and type size that you want QuoteScan to use in the floating 
window.



Corel QuoteScan main window

The Corel QuoteScan allows you to monitor the stock price of up to five stocks on different North 
American stock exchanges. The information from the exchange can be viewed either in the main 
window or in a floating window that contains only the stock information.

Ticker symbol text boxes specify the ticker symbol of the stock that you want QuoteScan to keep 
track of.

Details of Ticker symbols display the details of the selected stock including company name, current 
price, price change, and trading volume.

Automatic update frequency list box specifies how often you want QuoteScan to update the price 
and volume of the selected stock.

Show Floating Window check box specifies whether you want QuoteScan to display its small 
floating window.

Ticker Style Scrolling check box specifies that you want QuoteScan to scroll the stock information 
for the five selected stocks in the floating window.

Update Now button instructs QuoteScan to check the current prices of the selected stocks now.

Look Up button assists you in finding the ticker symbol of a company. The Look Up button uses your
Web Browser to access the PC Quote Web site and search for ticker symbols of companies that 
interest you.

PC Quote button launches your Web browser and accesses the PC Quote Web site.

Configure button displays the Options dialog box which allows you to configure the QuoteScan 
application.

About button displays the About dialog box which includes version information about QuoteScan.

Help button displays the table of contents of the on-line help for QuoteScan.

Hide button hides the main window of QuoteScan leaving only the floating window displayed. You 
can restore the main window by right clicking on the floating window and selecting Show Dialog.

Exit button exits from QuoteScan.



Specifies the ticker symbol of the first stock that you want QuoteScan to keep track of.



Specifies the ticker symbol of the second stock that you want QuoteScan to keep track of.



Specifies the ticker symbol of the third stock that you want QuoteScan to keep track of.



Specifies the ticker symbol of the fourth stock that you want QuoteScan to keep track of.



Specifies the ticker symbol of the fifth stock that you want QuoteScan to keep track of.



Displays the details of the selected stock including company name, current price, price change, and trading volume.



Displays the details of the selected stock including company name, current price, price change, and trading volume.



Displays the details of the selected stock including company name, current price, price change, and trading volume.



Displays the details of the selected stock including company name, current price, price change, and trading volume.



Displays the details of the selected stock including company name, current price, price change, and trading volume.



Specifies how often you want QuoteScan to update the price and volume of the selected stock.



Specifies whether you want QuoteScan to display its small floating window.



Specifies that you want QuoteScan to scroll the stock information for the five selected stocks in the floating window.



Instructs QuoteScan to check the current prices of the selected stocks immediately.



Assists you in finding the ticker symbol of a company. The Look Up button uses your Web Browser to access the PC Quote 
Web site and search for ticker symbols of companies that interest you.



Launches your Web browser and accesses the PC Quote Web site.



Displays the Options dialog box which allows you to configure the QuoteScan application.



Displays the About dialog box which includes version information about QuoteScan.



Displays the table of contents of the on-line help for QuoteScan.



Hides the main window of QuoteScan leaving only the floating window displayed. You can restore the main window by right 
clicking on the floating window and selecting Show Dialog.



Exits from QuoteScan.



About button

The About button displays version information about Corel QuoteScan.

To display the version of Corel QuoteScan that you're using:
1. From the Help menu, choose the About command.



Keyboard Short-cuts

Function Keyboard Short-cut

Update Now 
{button ,AL(`Updatin
g the stock price')}

Alt+U

Look Up 
{button ,AL(`Finding 
and adding ticker 
symbols')}

Alt+L

PC Quote 
{button ,AL(`About 
PC Quote')}

Alt+P

Configure 
{button ,AL(`Configur
ing the floating 
window')}

Alt+C

About 
{button ,AL(`About 
button')}

Alt+A

Hide 
{button ,AL(`Hiding')}

Alt+H

Exit Alt+X
Alt+F4

System menu is activated by clicking on the QuoteScan icon in the upper-left corner of the 
QuoteScan window. It contains commands which allow you to restore, move, size, minimize, 
maximize, and close the QuoteScan window.



Minimize reduces the window to an icon beside the clock on the task bar. This action occurs when 
you either choose the Minimize command from the System menu or click the left button in the upper 
right-hand corner of the window.



Maximize increases the window to the size of your screen. This action occurs when you either 
choose the Maximize command from the System menu or click the right button in the upper right-
hand corner of the window.



Size allows you to drag a border on the window to resize it.



Close shuts down the window.



Restore returns the window to its original size.



Move allows you to drag the window to a new location.



Switch To displays the Task List from which you can activate another application.



Caption bar displays the name of the current directory contents and pane.



Scroll bars advance the information in the current panel.



Using Help

If you require    help performing any function in QuoteScan, extensive on-line help is included in the 
software. If you're unsure of the operation of any menu command or the procedure for a specific 
function, the on-line Help in QuoteScan can probably help you.

Method of 
accessing Help

Type of information provided

F1 Key Provides help on the currently selected 
object. For example, if you select a menu
command and press F1, information on 
the use of the selected command is 
displayed.

Right mouse click Provides information on the selected 
object. For example: right click the 
mouse on a check box and choose 
What's This? from the menu to view an 
explanation of that check box.

Help button Provides an overview of the current 
dialog box or window.

How to... topic 
{button ,AL(`How 
to')}

This section of the Help file provides 
step-by-step instructions on performing 
many operations with QuoteScan.

You can browse through this Help file using the Browse buttons to become familiar with the help 
features available in QuoteScan.

To open the online QuoteScan Help file:
1. From the Help menu, choose the Contents command or press the F1 key.

To display Help for a specific dialog box:
1. Press the Help button on the dialog box.

To display Help for window elements such as buttons and list boxes:
1. Press the Shift and F1 keys at the same time and then click the element.



Configuring the floating window

To display the stock prices in a floating window:
1. From the main window, enable the Show Floating Window check box.

To configure the floating stock window:
1. From the main window, click the Configure button.
2. Enable the selections for the information you want displayed in the floating window. For 

explanations of each of the settings, right click on any of the check boxes.
3. Click the OK button.

To scroll the text in the floating window like a ticker tape:
1. In the main window, enable the Ticker Style Scrolling check box.

{button ,AL(`No Data in floating window')} Related topics



Updating the stock price

To update the stock prices immediately:
1. In the main window, click the Update Now button

To specify how often QuoteScan checks the stock prices:
1. In the main window, click the Automatic update frequency list box.
2. From the list select an item that best indicates how often you want QuoteScan to check the price of 

the selected stock.

{button ,AL(`No Data in floating window')} Related topics



Finding and adding ticker symbols

To add a stock to QuoteScan:
1. Type the ticker symbol of a company in one of the five Ticker Symbol text boxes.

To find the ticker symbol of a company:
1. In the main window, click the Look Up button.
2. QuoteScan launches your Web browser and attempts to connect to the PC Quote Web site. If it’s 

successful connecting to the site, you can look up a company ticker symbol by continuing to step 3. 
If it’s unable to connect to PC Quote, repeat steps 1 and 2    again later.

3. On the PC Quote Home page, click Name Lookup.
4. Type the name of the company for which you want to find the ticker symbol.
5. Click the Search button. After a few seconds, PC Quote returns a list of company names and ticker 

symbols that are closest to the name you typed.



How to...

display the version of Corel QuoteScan that you're using
open the on-line QuoteScan Help file
display Help for a specific dialog box
display Help for window elements such as buttons and list boxes
display the stock prices in a floating window
configure the floating stock window
scroll the text in the floating window like a ticker tape
update the stock prices immediately
specify how often QuoteScan checks the stock prices
add a stock to QuoteScan
find the ticker symbol of a company
access the PC Quote Web site
change the Run setting to minimized
hide the main window
display the main window after you  ’  ve hidden it  
access the PC Quote Web site
specify the Web browser that QuoteScan accesses



Minimizing and hiding QuoteScan on startup

Minimizing

After you’ve selected the stocks you want to monitor, you’ll probably want QuoteScan to run in the 
background (minimized) whenever your system is up and running. You can add QuoteScan to your 
Windows 95 Startup group and it will start whenever you system first starts. 

For information on adding a program to the Startup group, click {button ,AL(`Adding a program to 
the Starup group',1,`',`second')}.

You can specify that you want QuoteScan to run minimized whenever it starts by modifying its Run 
setting in the QuoteScan application properties settings. 

To change the Run setting to minimized:
1. Open the Internet Mania folder and click the QuoteScan icon. Don’t double click.
2. From the File menu in the Internet Mania folder, choose the Properties command.
3. Choose the Shortcut tab.
4. In the Run list box, select Minimized.
5. Click the OK button.

If you configure QuoteScan to display the floating window, and you specify that you want the 
application to run minimized, the QuoteScan main window is hidden and won’t display a button in 
the Windows 95 taskbar. You can access the main window by right clicking on the floating window 
and choosing the Show Dialog command from the menu.

If you specify that you want QuoteScan to run minimized, but you haven’t configured it to display 
the floating window, the application runs minimized and displays a button in the Windows 95 
taskbar.

Hiding

When you have the floating window displayed, you will probably want to hide the QuoteScan main 
window. When it is hidden, it won’t display a button in the Windows 95 task bar.

To hide the main window:
1. Click the Hide button in the main window.

To display the main window after you’ve hidden it:
1. Right click on the floating window and select Show Dialog from the menu.

If the Web site that's supplying the stock prices isn’t responding, the floating window disappears.



About PC Quote

PC Quote, Inc. provides high quality securities quotations and news to hundreds of thousands of 
professional and private investors around the world. Our data is on PCs everywhere, supplied 
through leading on-line services, the World Wide Web, Cable TV lines, or directly by satellite.

PC Quote has a Web site that QuoteScan accesses to obtain stock price and volume information. If
you have a Web browser installed on your system, you can access the PC Quote Web site.

To access the PC Quote Web site:
1. Make sure you have a Web browser installed on your system and make sure you’ve properly 

configured QuoteScan to access your browser by configuring the Browser tab of the Options dialog.
{button ,AL(`To specify the Web browser that QuoteScan accesses')}

2. Click the PC Quote button in the QuoteScan main window.



Disclaimer

All data is delayed 20 minutes unless noted, and is believed accurate, but isn't warranted or 
guaranteed by PC Quote, Inc. or Corel Corporation.



Adding a program to the Startup group
To add a program to the Start or Programs menu
1 Click the Start button, and choose Settings.
2 Click Taskbar, and click the Start Menu Programs tab.
3 Click the Add button.
4. Click the Browse button.
5. Locate the program you want to add, and double-click it.
6. Click the Next button, and double-click the menu on which you want the program to appear.
7. Type the name that you want to see on the menu, and click the Finish button.

If Windows prompts you to choose an icon, click one, and then click the Finish button.



No Data in floating window

Sometimes, the ticker information in the floating window may be replaced by the message "No Data". 
This message is displayed when QuoteScan can't get price and volume information from the PC 
Quote Web site. There are three possible causes of this problem: there is a problem with your Internet
access; the Internet connection route to PC Quote is not functioning properly; or there is a problem at 
the PC Quote Web site.

Check your Internet connection first to make sure you can access other services. For example, use 
your Web browser to connect to a Web site. If you can connect properly, the problem is being caused 
by the network or by the PC Quote Web site. Wait for a while and try again. In most cases, the 
problem will last only a few minutes. If the problems persist for hours or days, contact PC Quote. 
Contact information for PC Quote is in the Internet Mania README.TXT file.




